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How To Download The Program

From the www.redriversoft.com website, select the Downloads
Button.

Before you go any further 1 would create two-folders on your desktop.
Name one of them PastPerformance Data Files and the other Results Data
Files.

Left click on the blue link named: Click Here To Download EZ Money
2010 1.3 Beta.

You will have 3-Options. Run, Save and Cancel. Select Save to save the

program to your computer=s hard drive. The next Windows Save As has a
Save In feature which will allow you to navigate to where you want to save
the EZ Money program. The default will be C:/ Program Files. Now go to:
Install 2 on the next page of this manual: To Install From A Download to
install the program.

How To Download The User Manual

From the www.redriversoft.com website, select the Downloads
Button.

Select either the EZ Money User Manual Word Document Format link or the
EZ Money User Manual Adobe PDF Format link. |If you have a word processor
program, you will probably be able to read the user manual without
downloading the manual. The same holds true for the Adobe PDF file if you
have the Adobe software installed on your computer. Just click on the
link and then Open and the program will open up the user manual fTile.

How To Download The Past Performance Data File
Go to the www_.brisnet.com website.

Type in the following Domain Name into your favorite website browser:
www.brisnet.com. You are now at their Home Page: SELECTIONS, PROGRAMS &
PPS [Selections] [Entries/Programs] [Past Performances] [Australia] [Data
Files] [Sports] You will see the phrase Software Data Files. Just below
is the data file EZ Money uses. PP Data Files (single) Comma-Delimited
Past Performances (single file format). Select the Track and Date you
want to download. The lower case p to the right of the date means that
the file has already has the morning line odds and some entries have



already been scratched.



How To Download The Results File

Go to the www_brisnet.com website.

From the www.brisnet Home Page Select Results & Charts. Under the header
Result Data Files select Import Results Files: Comma-delimited data files
containing official finish position and odds. Select the file and date
from the correct track and download it to your Results File folder.

How To Read The Read Me File

Open your favorite word processing program. Navigate to the EZ Money folder which was
jJjust installed when you installed EZ Money on your hard drive. The routine is C:
Program Files/Red River Software/EZ Money 2010 Versionl.3 /Read Me First.

Installing EZ Money 2010 On Your Computer.
Install 1: To Install From A CD.

Start Microsoft Windows XP.

Select Control Panel.

Select Add/Remove Programs.

Select Add New Programs.

IT you have a CD, insert it into your CD player.
Select CD or Floppy.-

Select Next.

Select Finish.

Select Next.

Read the Licensing Agreement, and if in agreement, click on
Yes to accept.

11. Select Next to Install in the directory EZ Money 2010.
12. Select Next to create lcons.

13. Select Finish.
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Install 2: To Install From A Download.

1. Start Microsoft Windows XP.

2. Double Click On The ezmsetup File.

3. Select Run.

4. Select Next.

5. Read the Licensing Agreement, and if in agreement, click on 1
accept the terms in the license agreement, to accept.

6. Select Next. Read the Readme Information.

7. Select Next.

8. Select Install.

9. Select Finish.



Uninstall:

Caution: Do not uninstall the program which has expired until you
have installed the new program and merged your secret horses into the
new program.

From Start select Settings.

Select Control Panel.

Select Add/Remove Programs.

Select the program you want to remove.
Select Add/Remove.

Answer Yes to Confirm File Deletion.
Click on OK

QUICK START PROCEDURES

At the upper left part of the program, under the EZ Money logo, select File. Choose
either Bloodstock DRF File... or Bloodstock NRX File... You should select the type of
file you downloaded for use today. A window will appear in the center of your

computer=s monitor; it will display only the type files which you have just selected.
You will see either the Look in: Desktop which is the default location or Look in: and
the icon of an Open Folder showing you which folder you are looking into. If you do
not see your file, navigate by way of the two-arrows to the far right of the window
which the program just opened until you arrive at the location of the data file you
downloaded earlier.

The default location is your desktop.

Either double click on the file name or select the file and then select open to open
the file.

You can change the default folder by selecting Settings under the Option menu. The
Settings Help option is very complete on this part of the program.

Under the Reports menu, select the Tip Sheet 1-6, which you want to have the computer
create. Under the same menu you may also have workouts or past performances
displayed.

Under the Option menu you can scratch a horse or check your secret horses.

To print any report, select print under the file menu or control P from the keyboard.
The program, on some printers, does not recognize legal paper and will treat it like
letter size.

A good source for some secret horses, or maybe not so secret are the: Turf Monthly

magazine and the Friday=s edition of the Daily Racing Form.



May 01, 2010

Welcome to the world of computer handicapping This program is very easy to use but just in case
you are new to computer handicapping, | want to take this opportunity to explain my program.

ABOUT THE PROGRAMMER

I am a retired USAF air traffic controller. | have a Bachelor degree in Computer and Information
Science, University of Maryland. 1 authored a daily tip sheet for over three years for the
Remington Park track in the Oklahoma City area, the tip sheet which was sold throughout Oklahoma
City and in Tulsa was called The Winning Horseman. The tip sheet was not sold at the track. The
first meet 1 participated as a published handicapper, my tip sheet won the category of most winners
from First selection and most money won on first selection. Fall 1992 Remington Park thoroughbred
meet. The following meet, (Spring 1993) after the first three weeks of racing, (120 races) 1 led
the meet with 46.66 percent winners from my top selection. 1 was in 2nd place in the winners on
top category with 14 days remaining in the meet when | decided that handicapping required the use
of a computer and quit the tip sheet to start working on this program.

I immediately started working on this program and was back in the tip sheet business (Fall 1993).
It took several meets to get the program to handicap like a veteran, but by (Fall 1994) my computer
won the first place trophy for best overall tip sheet (Fall 1994), sponsored by the late Toby
Vaughan the proprietor of Toby"s TIPS of Oklahoma City.

In my First Las Vegas tournament, | placed eighth in the mutual division of the World Cup of
Thoroughbred Handicapping Las Vegas, Nevada August 1995.

I continue to improve the EZ Money program. | believe that this program is the best available at
any price for handicapping thoroughbreds. 1 believe this so strongly that 1 will not sell you this
program. However, I will lease it to you for 90 days at a time. This program will stop working
when the agreed time has expired. This will be addressed prior to the installation of the program
when you have to agree to the licensing agreement before the program will install.

PROGRAM INFORMATION

The program was designed with the thought that you do not need to download another data file. That

is why 1 designed the program to use two of Bloodstock=s one dollar data files which you may
already be down loading for another program. This gives you another opinion of the race without
the additional cost of buying another data file.

In the future, 1 hope to have the program using a data file from another company. This could help
you not be inoperative if Bloodstock has a computer problem and the data files are not available.

DATA ENTRY:

The horse=s past performances are available from Bloodstock Research Information Services,
Incorporated. You must have an account with them so you can download the data file. The program
currently uses either of two one-dollar data files: The $1.00 Daily Racing Comma Delimited data
file (single file format) or the Neurax one dollar file. Both files are sold by Bloodstock
Research.

Neurax is a trademark of Brain Child Software.

Bloodstock Research Information Services, Inc.

801 Corporate Drive, Suite 300 * P.O. Box 4097, Lexington, Kentucky 40544
(606) 223-4444 or (800) 354-9206 * Fax: (606) 223-7024

Website www.brisnet.com



PROGRAM FEATURES

Without letting anyone know how my program works. 1 want to give you some aid in the use of the
program, its features and weaknesses.

The program has the ability to use either of two data Ffiles with exactly the same results.
The DRF DATA FILE or NEURAX DATA FILE.

Both file consists of up to 1435 fields of information on each horse. If the horse is a first time
starter in the United States, the information is limited. The program®s development was started

April 1997. That makes the intelligence=s of the program, at the time of this writing, about 13-
years old.
Options

SETTINGS: Found under Options. Allows you to individually adjust the program to your liking. You
may set different directories (folders) for the past performances data files the result files and
the program generated report files. 1 recommend that you do not delete your generated reports such

as Tip Sheets until you exit the program because the four Most Recently Used reports available

under the File Menu which may be recalled instantly will not be available and have to be
regenerated.

CHOOSE FONTS: Found under Options. After you create a report the function becomes available. When
you select Choose Fonts a window will open allowing you to choose the Font, Font Style and Size. In
most cases you may also choose a size which does not appear to be available. Simply type in the
desired size you would like to view and then select OK or hit the Enter key on your keyboard. It
must be an integer with no decimal fractions.

SCRATCHES: Found under Options. The only restriction to scratching horses is that if you scratch
all horses in any one race, none of the program reports will work. You may scratch a horse in two
ways: First, select the horse and then select Scratch. Second, double click on a horse which has
not previously been scratched and select OK. |If you select OK before you are finished scratching

all of the horses you want to scratch. You will have to wait until the program saves the current

scratch information before you may continue.

SECRET HORSES: Found under Options. The purpose of this option is for you to enter a particular
horse®"s name and a comment about the horse. The next time you handicap, the program will check for
your secret horses, to see if any are running today. |If any secret horses are running today, the
program will display the comment you typed in previously as you scroll up or down using the arrow
keys through the horse®s names. The maximum allowed number of comments are 65,768.

You may add horses simply by selecting the horse®s name and then typing in the comment. You may
also add horses from any source as long as you know the exact spelling of the horse®s name.
Remember that all horse names will appear in capital letters and you should always use capital
letters in the SECRET HORSE horse name routine. You may use upper or lower case letters in your
comments. The lower case letters actually gives you more room for your comments.

To add a horse using a data file: Under the file menu select the type of file which you want to
read: Bloodstock DRF File or Bloodstock NRX File. Wait a moment while the program verifies the
data file. Then under the Options Menu select Secret Horse(s). The computer will read in all of
your Secret Horse data and display two tab dialogs: The front most will be your file name and the
second will be All Horses. To see if there are any secret horses in that particular data file,
scroll down through the list with the down arrow key. All the array keys should work including the
Pgbn,PgUp,Home and End Keys.

To add a comment to an existing horse whether it already has a comment or not, select the
individual horse with the left mouse button, and then under Comments select New. An Add Comment
dialog will become visible showing a date. The program will suggest the date of the data file.
This can be changed by using the small up or down arrows beside the date. Next, click in the
Comment window and type in your comment. The comment may be upper or lower case. |If you need more
room for your comments try using lower case letters. Then click OK to save the comment.



The following examples are how 1 personally make my comments:

CODE MEANING

5WiT five wide 1st turn

5WA1T 4W2T 6WS five wide 1st turn, four wide 2nd turn, six wide stretch
AWBT four wide both turns

6WBS six wide back stretch

SI1+2 HML speed index plus 2 points, had more left

SI+4 NA speed index plus 4 points, never asked

S1+6 Stdy Sharply speed index plus 6 points, steadied sharply

SI+1 Mild Steady speed index plus 1 point, mild steady

SI+2 NAO speed index plus 2 points, not all out

To add a horse without using a data file: Under the Options Menu select Secret Horse(s). The
Secret Horses All Horses Tab will appear with two dialog boxes. The dialog box to the left is
named Horse and contains all of the horses in your Secret Horse list. To add a horse to the list,

select New under the word Horses. A dialog box will appear for you to type in the horse=s name.
Next select New under the word Comments. Today"s date will appear which may be changed by using

the small arrows to the right of the date. Type in the horse=s name using all capital letters and
then exit by selecting OK to leave the comment dialog and OK to leave the Secret Horse routine.

You may also delete or edit existing comments. When you exit the Secret Horse routine the program
will check to see if all horse still have comments, if any do not have a comment the program will
delete the horse"s name from the Secret List data file. You may also Purge comments if they get too
old and start to slow your computer down or Fill up your hard disk. You may keep the first most
recent or First and second most recent comment and delete the third and fourth back etc. comments.
You also have an option to delete comments from a particular date. A word of caution, deleting
comments is a one way trip.

MERGE SECRET HORSES: Found under Options. The purpose of this option is to allow you to add all
of your previously saved secret horses into your new program. First under Options click on Merge
Secret Horse(s). A Window will open. At the top of the window will be the statement Select EZ
Money HW file. You will have to navigate via this window until you find your current HW file.
Select the file and then select open. The program will then merge the secret horses in the file
you just opened into your current HW file in the new program.

TIP SHEETS

Format 1 through Format 6 are found under Reports/Tip Sheets
All Tip Sheets have the same scores for the order which the program thinks the
horses will run today. Tip Sheet 1-6 are available with both data files.

Tip Sheet Format 1
Top five selections in the order in which the computer thinks that the horses will
run today.

SAMPLE:
PIM May 16, 2009

R S e o S S R S R S R S

RACE #5 AT PIM

3 10-1 OUR BIG WALLY 92.33
1 20-1 MOTOWN SHUFFL 92.06
9 15-1 ROBEY"S CHOIC 86.69
11 9-2 CHANCELLERY 86.67
2 4-1 SCHLEPROCK 86.32



The following symbols are used to explain Tip Sheet 2 through Tip Sheet 6 Level 1.

* in front of the PN means that this is a watch horse, an individual that may run better than
indicated
PN is the program number

ODDS  the morning line odds

NAME the First eight characters of the horse=s name
SCORE the total points assigned to the horse-the higher the number the better

* in front of the horse=s AGE indicates first time lasix
AGE the age of the horse
C colt

DSA distance which speed figure (SP) was achieved. The D stand for dirt and the T for turf.
DSLR days since last race

ES1 the two-furlong speed figure

ES2 the four-furlong speed figure

F filly

FIT fitness-the computer tries to calculate how well the horse is conditioned for today=s race
H horse

M mare

o] after the horse=s gender indicates blinkers on

L after the horse=s gender indicates blinkers off

FIT fitness-the higher the number the better
WKS the number of workouts since the last race and the total number of furlongs worked

D the number of day since the most recent workout since last out

WK the distance of the workout in furlongs and the type workout, for example Hg,Bg,H or B

RANK  the rank of the workout among all workouts at that distance that day

RR the race rating of the last race the horse ran

T turn-time-this is a time in seconds (for the first race back)for the time from the 2 pole to

the 174 pole. The lower the number the faster he/she traveled the turn
Trouble Line the Daily Racing Form trackman=s last race comment
Tip Sheet Format 2
Full field format with Jockey Stats.
JOCKEY the last name of the jockey riding today

STARTS the number of starts the jockey has had
WIN % the winning percent of the jockey

SAMPLE:

SA March 4, 2010

RACE #1 AT SA: Md 25000, Purse $15,000 at 5 Furlongs on the MAIN track Class PAR 85

PN ODDS NAME SCORE  AGE DSLR FIT ES1 ES2 LS FS DSA TT JOCKEY STARTS  WIN %
5 5-2 SMOKEY BEAU 85.6 4G 64 72 88 86 67 72 8.0D 25.57 LEYVA 0 0.0
3 6-1 A PINT FOR M 76.0 4G 12 88 85 86 75 73 5.5D 23.67 SORENSON 40 10.0
9 8-1 JOLLEY DRIVE 75.8 4G 17 83 83 77 78 68 6.5D 23.50 JAMES IC 9 0.0
2 7-2 CHAILEPIS 74.0 5G 12 97 81 85 73 71 5.5D 23.72 GARCIA A 193 11.9

10 9-2 WARREN"S BIG 71.9 4C 21 83 84 88 71 69 6.0D 22.61 AMADOR 1 71 8.5
4 30-1 EMINENT HONO 70.8 5G 6 94 90 91 66 72 7.0D 23.01 HERRERA 2 0.0
1 20-1 IMAGE AND LI 67.8 4Gf 33 67 86 77 71 62 5.5D 24.33 ATKINSON 19 21.1
8 10-1 SOUVENIR SuM 61.1 *4C FTS 82 0 0 0 0 0.0 TALAMO O 245 11.0

*6 10-1 JAMES M. DEA 55.3 *6H FTS 88 0 0 0 0 0.0 SANTIAGO 122 10.7
7 12-1 VALIANT WOND 53.9 5G 29 97 91 90 42 49 6.5D 23.26 PEDROZA 100 12.0



Tip Sheet Format 6 Level O
Class Par-means that the average winning BRIS final speed figure is 82 for this class level.

SAMPLE
OSA October 18, 2008

RACE #1 AT OSA: Md 40000, Purse $21,000 at 6.5 Furlongs on the MAIN track Class Par 82

PN ODDS NAME SCORE AGE DLR FIT WKS D WK RANK D WK RANK RR  TROUBLE LINE LAST RACE
4 4-1 0 FIREFL 79.27 2F 16 91 1/5 [6 5FfH 5/54] [------—--——-- 1 104.8 4wd into str;late bid
3 5-1 MA BARKE 78.16 2F 22 85 1/5 [6 5FH 49/54] [------——-——-- 1 104.3 5wd into striwillingly
7 5-2 PLAZAQU 76.54 2F 16 84 0/0 [--——————————- 1 [-————————- ] 104.8 Bobbled;off bit slow
8 7-2DIXIEHA 76.09 2F 16 89 1/4 [6 4FfH 51/65] [-—--———————— 1 104.8 Stalked;up btwn 3rd

*2  4-1 CRAZY TR 74.36 2F 24 82 1/5 [7 5FfH 15/45] [-—---——-——-— 1 109.1 Bit crowded 3/16;wkend
1 15-1 BONITA B 70.42 2F 29 71 0/0 [-—-————————m- 1 [-——————- ] 104.3 Rail; 3wd; lacked bid
6 20-1 KITTY KA 67.32 2F 26 80 1/5 [7 5FfH 38/45] [-——-———————— ] 104.8 4wd; 3wd; lacked bid
5 10-1 DANIELLA 63.64 2F 9 91 0/0 [--—————————m- 1 [-—————————- 1 104.5 Speed;inside;wkened

Tip Sheet Format 6 Level 1

TE-——————- means total entries in their previous race not counting themselves or first-time-
starters.

APLR--—--- means the average purse last race, not counting themselves or any first-time-starters.
N/A-—————— means that the previous race date file was not available.

Class Par-means that the average winning BRIS final speed figure is 82 for this class level.

Full Field Format With the Average Purse value of each individual =s previous race.
Presently requires to be printed out in Landscape mode for the entire tip sheet to fit on
paper. This will probably change when the final version of the program is finished.

SAMPLE
OSA October 18, 2008

RACE #1 AT OSA: Md 40000, Purse $21,000 at 6.5 Furlongs on the MAIN track Class Par 82

PN ODDS NAME SCORE AGE DLR FIT WKS D WK RANK D WK RANK RR  TE APLR
4 4-1 0 FIREFL 79.27 2F 16 91 1/5 [6 5FfH 5/54] [---—--——————- 1 104.8 7 34,714
3 5-1 MA BARKE 78.16 2F 22 85 1/5 [6 5FH 49/54] [--———-——————- ] 104.3 5 23,200
7 5-2 PLAZAQU 76.54 2F 16 84 0/0 [---—————————- 1 [--————————-- ] 104.8 7 31,000
8 7-2 DIXIEHA 76.09 2F 16 89 1/4 [6 4fH 51/65] [-----——-——-— 1 104.8 7 34,714
*2  4-1 CRAZY TR 74.36 2F 24 82 1/5 [7 5FfH 15/45] [-—---——————— ] 109.1 5 46,600
1 15-1 BONITA B 70.42 2F 29 71 0/0 [-—-—————————- 1 [-—————————- ] 104.3 Data File N/A
6 20-1 KITTY KA 67.32 2F 26 80 1/5 [7 5fH 38/45] [-——--——-———— 1 104.8 Data File N/A
5 10-1 DANIELLA 63.64 2F 9 91 0/0 [---———————mm- | [ 1 104.5 10 30,700

PAST PERFORMANCES TYPE 2:

SAMPLE Header:

RACE # 1-2 CRAZY TRICIA 4-1 3F CP 86 Purse FS PP S 1C BL 2C BL SC BL FC BL FP/TE M/E DSLR 24, L, NEC, 1/5

The above line is the header for the past performances and means: Race # 1; program number 2;
Horses name CRAZY TRICIA; the morning line odds; the age and gender; class par; the amount of the
purse that the horse ran for in the most recent race; the final speed figure; the post position;
the position he/she broke from at the start of the race; the position at the first-call; the beaten
lengths or lead; the position at the second-call; the beaten lengths or lead; the position at the
stretch-call; the beaten lengths or lead; the final call position; the beaten lengths or the
winners margin of victory; the finished position and number of entries; the medication and

equipment changes; days since last race; today=s medication; the number of workouts since the

horse=s last race and the total number of furlongs of those workouts since the horse=s last race.



SAMPLE BODY of the first race back past performance

19 1-4 10SA 080924 D 6.5F FT fsMdSpwt 44000 95.7 63 4 7 5 4.00 5 4.50 7 7.00 7 8.00 L Lugged out turn

The following lines are explanations to the above symbols used:

19

1-4
10SA
080924

D

6.5F

FT
fsMdSpwt
44000
95.7

63

a o
o o

N~N~NAOAOIND
o
I

LB

Track 1D
Date

Surface

Distance
Track condition
Race Type
Purse

TT

FS

PP

S

1C

BL

2C

BL

SC

BL

FC

BL

Nose

Head

Neck

TE
Medication

Lugged Out turn

the number of days off before that race

the individual had one-workout for four-furlongs before that race
the first race at Santa Anita Park

September 24, 2008

dirt, a lower-case d@E} t would mean the inner track

6.5 furlongs

fast track

Maiden Special Weight race

$44,000 purse

turn-time, the higher the number the faster
BRIS Final Speed Figure

post position

the individual broke in the 7" position
the first call position

beaten lengths or leader margin

second call position

beaten lengths or leader margin

stretch call position

beaten lengths or leader margin

final call position

beaten lengths or leader margin

The individual won by a nose.

The individual won by a head.

The individual won by a neck.

total entries in that race

Lasix and Bute

trouble line comment for the most recent race

IT you want the following past performances to be printed in a portrait format, do not use larger

type than Courier New 8 point.

If you want larger print, select,

Using the portrait format uses a lot less paper.

landscape in the print menu. You may use much larger print but

you will not have as many individual=s printed on one sheet of paper.

SAMPLE Last 6 Races With Zero Workouts

SA Feb 18, 2010

RACE # 2-3  ABSOLUTE GLORY 6-1 8H CP 89 Purse FSPP S1C BL 2C BL SC BL FC BL M/E DSLR 22, L, NEC, 0/0
11 1- 6 6SA 100127 D 7.0F FT CIm10000 13000 85 1 9 9 6.25 9 6.50 8 4.00 4 2.25 LBb OFF bit slow;best rest
21 0- 0 4SA 100116 D 8.0F FT CIm10000 14000 86 1 9 9 8.00 9 5.50 8 4.00 4 1.50 LBb OFF bit slow;tight 7/8
48 5-26 2SA 091226 D 8.5F FT CIm8000 11000 83 4 4 6 2.75 6 4.75 6 3.50 3 0.75 LBb Came out str;willingly
60 5-27 10SA 091108 D 8.0F FT CIm12500nly 11000 67 7 9 9 13.00 9 14.00 9 9.75 8 19.00 LBf 4wd 1st turn;outrun

250 1- 3 7DMR 090909 D 6.5F FT 0C62500n$y 62000 70 4 3 4 6.25 4 7.00 4 11.00 4 18.25 LBf Saved ground; outrun
40 0- 0 4SA 090102 D 7.0F FT CIm62500 43000 86 710 9 5.00 9 6.25 9 6.50 8 6.25 LBf 3wd;5wd; no rally

SAMPLE Last 6 Races With Last 4 Workouts

SA Feb 18, 2010

RACE # 2-3  ABSOLUTE GLORY 6-1 8H CP 89 Purse FSPP S1C BL 2C BL SC BL FC BL M/E DSLR 22, L, NEC, 0/0
11 1- 6 6SA 100127 D 7.0F FT CIm10000 13000 85 1 9 9 6.25 9 6.50 8 4.00 4 2.25 LBb OFF bit slow;best rest
21 0- 0 4SA 100116 D 8.0F FT CIm10000 14000 86 1 9 9 8.00 9 550 8 4.00 4 1.50 LBb OFF bit slow;tight 7/8
48 5-26 2SA 091226 D 8.5F FT CIm8000 11000 83 4 4 6 2.75 6 4.75 6 3.50 3 0.75 LBb Came out str;willingly
60 5-27 10SA 091108 D 8.0F FT CIm12500nly 11000 67 7 9 9 13.00 9 14.00 9 9.75 8 19.00 LBf 4wd 1st turn;outrun

250 1- 3 7DMR 090909 D 6.5F FT 0C62500n$y 62000 70 4 3 4 6.25 4 7.00 4 11.00 4 18.25 LBf Saved ground; outrun
40 0- 0 4SA 090102 D 7.0F FT CIm62500 43000 86 710 9 5.00 9 6.25 9 6.50 8 6.25 LBf 3wd;5wd; no rally

Janl7 SA 6Fft 74.6 H 1/2,

Decl8 SA 7Fft 87.

0 H 1/3, Decl0 SA 6Fft 74.4 H 7/16, DecOl1 SA 5Fft 61.6 H 13/31



SAMPLE Last 6 Races With Last 8 Workouts
SA Feb 18, 2010

RACE # 2-3  ABSOLUTE GLORY 6-1 8H CP 89 Purse FS PP S 1C BL 2C BL SC BL FC BL M/E DSLR 22, L, NEC, 0/0

11 1- 6 6SA 100127 D 7.0F FT CIm10000 13000 85 1 9 9 6.25 9 6.50 8 4.00 4 2.25 LBb Off bit slow;best rest
21 0- 0O 4SA 100116 D 8.0F FT CIm10000 14000 86 1 9 9 8.00 9 5.50 8 4.00 4 1.50 LBb Off bit slow;tight 7/8
48 5-26 2SA 091226 D 8.5F FT CIm8000 11000 83 4 4 6 2.75 6 4.75 6 3.50 3 0.75 LBb Came out str;willingly
60 5-27 10SA 091108 D 8.0F FT CIm12500nly 11000 67 7 9 9 13.00 9 14.00 9 9.75 8 19.00 LBf 4wd 1st turn;outrun
250 1- 3 7DMR 090909 D 6.5F FT 0C62500n$y 62000 70 4 3 4 6.25 4 7.00 4 11.00 4 18.25 LBFf Saved ground; outrun
40 0- 0O 4SA 090102 D 7.0F FT CIm62500 43000 86 7 10 9 5.00 9 6.25 9 6.50 8 6.25 LBf 3wd;5wd; no rally

Janl7 SA 6Fft 74.6 H 1/2, Decl8 SA 7Fft 87.0 H 1/3, Decl0 SA 6Fft 74.4 H 7/16, DecOl1 SA 5Fft 61.6 H 13/31
Nov23 SA 4Fft 49.6 Hg 25/32, Novl3 SA 4Fft 49.6 Hg 20/34, Oct3l OSA 6Fft 75.4 H 16/20, Octl9 OSA 5Fft 61.8 H 23/31

SAMPLE Last 6 Races With Last 12 Workouts

RACE # 2-3 ABSOLUTE GLORY 6-1 8H CP 89 Purse FS PP S 1C BL 2C BL SC BL FC BL M/E DSLR 22, L, NEC, 0/0
11 1- 6 6SA 100127 D 7.0F FT CIm10000 13000 85 1 9 9 6.25 9 6.50 8 4.00 4 2.25 LBb Off bit slow;best rest
21 0- 0O 4SA 100116 D 8.0F FT CIm10000 14000 86 1 9 9 8.00 9 5.50 8 4.00 4 1.50 LBb OFf bit slow;tight 7/8
48 5-26 2SA 091226 D 8.5F FT CIm8000 11000 83 4 4 6 2.75 6 4.75 6 3.50 3 0.75 LBb Came out str;willingly
60 5-27 10SA 091108 D 8.0F FT CIm12500nly 11000 67 7 9 9 13.00 9 14.00 9 9.75 8 19.00 LBf 4wd 1st turn;outrun
250 1- 3 7DMR 090909 D 6.5F FT 0C62500n$y 62000 70 4 3 4 6.25 4 7.00 4 11.00 4 18.25 LBf Saved ground; outrun
40 0- 0 4SA 090102 D 7.0F FT CIm62500 43000 86 7 10 9 5.00 9 6.25 9 6.50 8 6.25 LBf 3wd;5wd; no rally

Janl7 SA 6Fft 74.6 H 1/2, Decl8 SA 7Fft 87.0 H 1/3, DeclO SA 6Fft 74.4 H 7/16, DecOl1 SA 5Fft 61.6 H 13/31
Nov23 SA 4Fft 49.6 Hg 25/32, Novl3 SA 4Fft 49.6 Hg 20/34, Oct31l OSA 6Fft 75.4 H 16/20, Octl9 OSA 5Fft 61.8 H 23/31
Oct07 OSA 6Fft 75.6 H 11/19, Sep27 FPX 5Fft 61.0 H 4/7, Sep2l FPX 5Fft 62.6 H 4/7, Sep05 FPX 3Fft 37.4 Hg 15/18

SAMPLE Last 6 Races With Secret Horse Comments
SA Feb 18, 2010

RACE # 2-3 ABSOLUTE GLORY 6-1 8H CP 89 Purse FS PP S 1C BL 2C BL SC BL FC BL M/E DSLR 22, L, NEC,0/0

11 1- 6 6SA 100127 D 7.0F FT CIm10000 13000 8 1 9 9 6.25 9 6.50 8 4.00 4 2.25 LBb SI+1 off slow

21 0- 0 45A 100116 D 8.0F FT CIm10000 14000 8 1 9 9 8.00 9 5.50 8 4.00 4 1.50 LBb SI1+2 Lacked Rm Turn
48 5-26 2SA 091226 D 8.5F FT CIm8000 11000 83 4 4 6 2.75 6 4.75 6 3.50 3 0.75 LBb 4 Wide Stretch

60 5-27 10SA 091108 D 8.0F FT CIm12500ny 11000 67 7 9 9 13.00 9 14.00 9 9.75 8 19.00 LBf 5 Wide 15* Turn

250 1- 3 7DMR 090909 D 6.5F FT 0C62500n$y 62000 70 4 3 4 6.25 4 7.00 4 11.00 4 18.25 LBf Rail Trip

40 O0- 0 4SA 090102 D 7.0F FT CIm62500 43000 86 7 10 9 5.00 9 6.25 9 6.50 8 6.25 LBf 3wd Trn 5 Wide Stre

The following symbols are used in both of the following program formats 1 & 2 shown below.

PN Program number.

PP Post position.

0oDDS The morning line odds.

NAME The horse=s name.

ST State or Country of breeding.

AGE The horse=s age.

WGT The weight the horse is carrying today.

JOCKEY The last name of the jockey riding the horse today.
STS The number of jockey starts.

w The number of jockey wins.

P The number of jockey places.

S The number of jockey shows.

Win The win percentage.

1T™ The in the money percentage.

TRAINER The last name and first name of the horse=s trainer.
STS The number of trainer starts.

The number of trainer wins.
The number of trainer places.
The number of trainer shows.
First time lasix

Blinkers on.

Blinkers off.

= O W TV=



Program Format 1: Sorted in the order most likely to win.

SA Feb 18,
RACE #5 AT SA , is a Claiming Race for, $40,000, Purse $32,000 at About 6.50 Furlongs on the TURF
PN ODDS NAME ST AGE WGT JOCKEY SIS W P S WIN % TRAINER STS W P S WIN %
7 30-1 EL NADIA NZ *7M 121 BAZE 129 15 13 14 11.6 KNAPP STEVE 3% 0 0 6 0.0
4 3-1 BIRDIE BIRDIE KY 5M 123 VALDIVIA 40 4 5 4 10.0 CANANI JuLIO C 37 12 6 3 32.4
9 2-1 SLEEP TIGHT FL 5M 121 GARCIA A 160 20 13 18 12.5 MITCHELL MIKE 49 10 15 6 20.4
1 5-2 TAMERIN KY 5M 121 ROSARIO 169 29 28 23 17.2 MITCHELL MIKE 49 10 15 6 20.4
5 8-1 TRIPLE STAR Nz 5M 121 BAZE 87 7 9 14 8.0 VELASQUEZ DANNY 10 1 0 2 10.0
6 8-1 SEE N WIN KY 4F 121 BEJARANO 197 47 37 32 23.9 MOGER ED JR 12 0 0 3 0.0
3 15-1 CARNIVAL QUEE GB 5M 121 GOMEZ 133 27 22 27 20.3 CARAVA JACK 48 6 11 6 12.5
2 20-1 CLASSY ATTRAC KY 5M 119 SANTIAGO 100 12 9 9 12.0 MARTINEZ SILVER 20 0 1 2 0.0
8 15-1 GIRL OF PANGA GER 5M 121 SMITH 98 14 14 14 14.3 GREELY C BEAU 13 0 1 1 0.0
Program Format 2: Sorted in the order most likely to win.

SA Feb 18, 2010
RACE #5 AT SA , is a Claiming Race for, $40,000, Purse $32,000 at About 6.50 Furlongs on the TURF
PN ODDS NAME ST AGE WGT JOCKEY STS W P S WIN% ITM % TRAINER STS W P S WIN% ITM %
7 30-1 EL NADIA NZ *7M 121 BAZE 129 15 13 14 11.6 32.6 KNAPP STEVE 35 0 0 6 0.0 17.1
4 3-1 BIRDIE BIRDI KY 5M 123 VALDIVIA 40 4 5 4 10.0 32.5 CANANI JULIO C 37 12 6 3 32.4 56.8
9 2-1 SLEEP TIGHT FL 5M 121 GARCIA A 160 20 13 18 12.5 31.9 MITCHELL MIKE 49 10 15 6 20.4 63.3
1 5-2 TAMERIN KY 5M 121 ROSARIO 169 29 28 23 17.2 47.3 MITCHELL MIKE 49 10 15 6 20.4 63.3
5 8-1 TRIPLE STAR NZ 5M 121 BAZE 87 7 9 14 8.0 34.5 VELASQUEZ DANN 10 1 0 2 10.0 30.0
6 8-1 SEE N WIN KY 4F 121 BEJARANO 197 47 37 32 23.9 58.9 MOGER ED JR 12 0 0 3 0.0 25.0
3 15-1 CARNIVAL QUE GB 5M 121 GOMEZ 133 27 22 27 20.3 57.1 CARAVA JACK 48 6 11 6 12.5 47.9
2 20-1 CLASSY ATTRA KY 5M 119 SANTIAGO 100 12 9 9 12.0 30.0 MARTINEZ SILVE 20 0 1 2 0.0 15.0
8 15-1 GIRL OF PANG GER 5M 121 SMITH 98 14 14 14 14.3 42.9 GREELY C BEAU 13 0 1 1 0.0 15.4
Key Race:

Using Data Files:

You must specify the location of your .drf or .nrx data files in the Directories area
Data Files In Settings Under the Options Menu. The use of past performances data files
to identify a Key Race was deleted in EZ Money 2010 Version 1.2. It might be

reinstated at

Using Results Files:

You must have

a later date. There were very few hits.

all of your .res result files in the Results Files folder found in the

Directories area in Settings under the Options Menu. That is the only place the
program will look for them.

The (.res result) files may be in any folder, but must be identified in settings.

Winners:

then went on to win.

Winners Within 1 Length:
key race and then went on

Winners Within 2 Length:
key race and then went on

Winners Within 3 Length:
key race and then went on

The program will look for an individual who ran in the possible key race and

program will look for an individual who ran in the possible
to run within 1-length of the winner in another race.

program will look for an individual who ran in the possible
to run within 2-lengths of the winner in another race.

program will look for an individual who ran in the possible
to run within 3-length of the winner in another race.



Information Sheets:

#6 Race Workout Relationship:

This information sheet shows the individual=s history of workouts and races in a time
line so you will get a better feel as to if the horse should run better or worse today
than in previous races. |If the horse runs best when it has been off 21-days and has
received 2-workouts than you will be able to compare that history with how he/she was
prepared for today event.

Horses Name
Surface

Today=s Date
TK or Track
SF of Speed Figure

Dis or Distance

S or Surface
Conditions
Purse

WEAKNESS:

Although the program is getting better it still has trouble with first time starters. |1
personally do not play races with first time starters unless they have had a training race and |
have watched the race. These races are used to school the horse and many trainers do not want
their horses to run all out. Until computers can watch workouts and training races they will have
a most difficult time with races which include first time starters. As a rule of thumb I have
devised a
system which allows me to reduce the chances that a first time starter will beat my computers 1st

selection. The rule has to do with the score of the program=s 1st selection and the distance of

today"s race. |If the score on the program=s 1st selection is 90.00 or higher and the distance is
6.0 furlongs or longer, it would be very difficult for a first time starter to beat such a score.
A score of 85.00 or higher and the distance of today®s race being 6.5 furlongs or longer would also
be
very difficult for a first time starter to beat the program®s 1st selection.

You should be especially cautious when first time starters only show breeze (b) and breeze
from the gate (bg) type workouts.

The program will use the trouble line comment if it can interpret it as being meaningful for
today"s races. Caution, sometimes the trackman®s comment is not very accurate when it comes to
turn information, i.e., 6-wide turn. 1 have seen a horse run three-wide in the turn and end up
six-wide in the stretch and the trackman call the horse six wide turn instead of six wide stretch
or 6 wide 1/4 pole.

IT a horse is coming out of one of the outer post positions, and there are several horses
scratched from a lower post position number. The stewards will move all horses outside of the
scratched horse in; i.e., a horse scheduled to start from post 11 with the 3 and 8 horses
scratching will actually depart the gate from the 9 post position while wearing the 11 post
position saddle blanket. If you are at the track with a computer you should scratch the horses and
then re-handicap the race and check the scores.

New feature:

SAMPLE Last 6 Races With Last 4 Workouts and Fitness Figures
HOL Jul 03, 1999

RACE # 2-6 DAWN"S SLEWPY 6-1 3F CP 77 Purse PP 2Ff 4F 6F LS FS FP/TE M/E DSLR 22, L, NEC, WKS 0/0
5 1HOL 990611 D 6.0F FT fMd25000 14000 7 85 79 0O 72 62 5/8 LB 77 65 4 wide to turn
17 9HOL 990606 D 7.5F FT fsMd32000 17000 3 77 80 0 60 62 11/12 LB 78 No factor
12 8HOL 990520 D 7.0F FT fMd25000 15000 11 80 75 0 73 65 4/12 LB 85 Angled in; no rally
14 9HOL 990508 D 7.0F FT fsMd32000 9 87 74 0 23 29 12/12 LB 75 Chased;wide;gave way
15 3HOL 990424 D 6.5F FT fsMd32000 2 83 84 0O 60 60 4/8 LB 73 No rally



15 9SA 990409 D 6.0F FT fsMd32000 4 81 80 0 78 68 5/12 LB 73 No late bid

Junl0 SA 5Fft 61.8 H 13/20, May30 SA 3Fft 36.2 Hg 7/22, Mayl6 SA 5Fft 63.6 H 41/44, Aprl8 SA 3Fft 34.4 H 1/15



Disclaimer:
Past performance is not a guarantee of future success

PROGRAM LIMITATIONS

For best results, if a horse is scratched at the track and you are using a computer, you
should scratch the horse and allow the program to re-handicap the race, it will give you
better performance.

On occasions you will see the remark No Tr Race in the trackman trouble line
comment. This means no published training race. The program checks the last
four workouts and if It can not determine if any of the works were of the
training race variety, it gives this report. |If it found a training race it

reports how the individual ran in the race and gives the distance and date of the
race.

Some Watch Horses could be the favorite. However, the conditions are right for the
individual to run big and that is why it is identified as a watch horse.

Comments:

NEVER NEVER NEVER PLAY A SLOPPY OR MUDDY TRACK

Do not use this program to play a track which is muddy or sloppy today. The program
intentionally lowers the score of an individual who ran well in the mud or slop. This is
jJust about the exact opposite as to what you want.

I am very dedicated to having the absolute best thoroughbred handicapping program possible
and | hope to have you as a customer for a very long time.

IT¥ you have any suggestions that would make the program a better tool, or know something
peculiar to your favorite track and you think it will help the program, 1 would be very
interested in hearing from you.

All of the tip sheets and the two-programs are sorted in the order: most likely order of
finish.

The program=s top selection is the individual with the highest score.

The past performances will not fit on legal paper in the portrait mode unless the font size
is 8 point or smaller. In landscape mode it will fit on letter paper with a font size as
large as 11 point. There are many types of fonts so experiment to find one that best suites
you.

IT the track condition of a workout was firm, then you should consider that the work was on
the turf.

You need to do some work on your own in reference to first time starters. The program tries
to move the first time starters as high as it can but you need to observe your favorite track
to see what score for a first time starter at that track can beat a 2" or 3™ time starter.
Each track is different, but some first time starters have the ability to beat other
experienced horses that have scores twenty-points higher than theirs. 1 will continue to

work on that but it is very difficult. Hint: If none of the individual=s with previous
races can run the Class Par, (keep in mind that these young horses are usually improving with
each

race)then I would look for a first-time-starter to run well. Usually someone has to run
close to the Class Par or better to win the race.



History Updates:

Special Note: In Workouts Last 12, 1 have placed a new routine that I am considering
releasing in a future version of the program. 1 do not know of anyone who is printing out
the Last 12 workouts since 1 have added them to all versions of the past performances and
that is why 1 have chosen that particular routine to place this new experimental race workout
relationship routine. Although this routine is not finished, it is accurate with the
information that it does display until it runs out of the 12-workouts in the current file.

1: New in 2003 version 3.3. 1 just got the fitness ratings from previous races
routine working. In past performances Last 6 Races with Last 4 Workouts, the fitness ratings

for previous races is now displayed just before the trackman=s trouble line comment, for

each of the last six races. To facilitate your handicapping, | also display today=s fitness
rating just before the 1°5* back race trouble line comment. That way you do not have to

constantly refer back to the tip sheet to check the individual horse=s fitness for today.

How it works. Each time you run a tip sheet, the program automatically updates and
stores all of the fitness ratings for each horse. When the horse runs again in two or three
weeks, the program will display the fitness for the previous race just before the

trackman=s trouble line comment. This feature currently only works in the following past
performance:

Past Performances TYPE 1
Last 6 Races
With Last 4 Workouts
With Finished Position Total Entries

2: New in 2009 version 3.1. In the header for Tip Sheet 2-6, | have re-worked the

program=s ability to decide today=s race conditions. However, when the program identifies
an Open Claiming race there is usually an age or gender restriction. When it displays DuCond
that means that there are two-conditions. One of the conditions will probably be money won,
in some time frame, or that the individual has not won at a certain distance in a certain

time frame. Some individual=s ignore these races unless they can decide for which horse or
horses the conditions were written. The other condition will be more conventional; for
example, non winners of 2 races lifetime. Abbreviated CImn2l or Alwn2l.

Remember DuCond means that there are duel conditions.

3: New iIn 2009 version 3.1. In Past Performances Type 2, the program now displays
purse value for many of the graded races. It also displays the purse information for more of
the foreign shippers.

4: New in 2009 version 3.2. Under OPTIONS Update Fitness Figures. This feature
allows you to have EZ Money Version 3.3 to read all of your drives to find DRF or NRX data
files and create fitness figures.

5: New iIn 2009 version 3.3. After each race description, both Tip Sheet 6s displays the
Class Par with a numerical value following. That value is the average BRIS final speed
figure for that particular race.

6: New In 2009 version 3.3. In Past Performances Type 2, immediately following the
number of days since the previous race, you will see the number of workouts and the total
furlongs worked before that race; for example, 100 6-24 means that the individual had been
off for 100-days and had received 6 published workouts for a total of 24-furlongs. The
current limitation for this feature is that there are only 12-workouts in the data file to
work with. In a future program the program will look back to see if you have any of the
other data files needed to check and see if there were additional workouts. |1 think that
this will work better than fitness figures because some trainers use: secret race tracks,
swimming pools and tread mills to condition their horses. A particular individual may have
been off 45-days and only shows one 4-furlong workout, the program will assign the horse a
low Fitness figure; however, if the horse always shows just one workout every 45-days and
usually runs well, you will have this information.

7: New In 2009 version 3.3. In Past Performances Type 2, immediately following the



horse=s name you will see a two or three-digit number. This number is the same Class Par as
displayed in Tip Sheet 6. It is the average winning BRIS final speed figure for the class
level.



8: New iIn 2010 version 1.1. In Past Performances Type 2, will display Jockey and
Trainer stats for the current meet. It will be in the format: Last Name, Starts 30, Wins 10,
Win-Percent 33_3-percent. It will look like this: Smith 30 10 33.3.

9: In 2010 version 1.1 I have expanded the width for your secret horse comment. You
should have room for more elaborate comments. Try printing out long comments to see which
font and case (upper or lower)fits best when you print out Past Performances Type I With
Secret Horses.

10: In 2010 version 1.2 , the program will display the Sire, Dam, Jockey and Trainer

information for individual=s who are first-time-starters, 2" time starters and 3™ time
starters. While playing at the track recently, 1 personally wanted that information for a
3" time starter and did not have it available.

11: In 2010 version 1.2 1 have changed some of the decimal beaten lengths to a more
conventional term. For example, 0.06 lengths is now NO for nose, 0.13 is now HD for head and
0.18 is now NK for neck. I will probably have a variation of the program which uses 1/74

length instead of 0.25, 2 instead of 0.50 etc.

In the near future, the program will look back through your past performance data files and
let you know how many workouts and how many furlongs each individual worked in preparation
for that particular race. 1 would suggest you keep all of your .drf files if you want that
information. The program currently only has access to the 12-workouts available in the .drf
data file you are using. The program is accurate until it uses all of the 12 possible
workouts. If an individual had more workouts the program does not have that information.

For example: if the individual had 6-workouts in preparation for today=s race and 8-workouts
in preparation for their first back race, the program does not know about the addition 2-

workouts because there are only 12-workouts in the past performance data file you are using.
This new expanded feature will almost for certain be available in EZ Money 2010 Version 1.3.

12: In 2010 Version 1.3 Past Performance Type 3 was added. It is our most complete
past performance to date. It is an expansion of Type 2 adding the weight carried for each of
the 6-past performance lines. BL which stood for beaten lengths has been replaced with LEN
which stands for lengths. Sometimes it means beaten-lengths and sometimes it means the
leader margin of winning. Also added is your secret horses. This past performances will
need to be printed out in landscape mode to prevent losing some of your output. Lastly we
added the country which the foreign shippers ran in during both of their last two-races.

This will be expanded to all past performances in the next update.

IT you have any problems, please contact us at:
ezmoney.support@redriversoft.com

Sincerely,
John R. Killiany



